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WARNING

CAUTION

Safety Notices

This product and related documentation must be reviewed for
familiarization with safety markings and instructions before use.

This instrument has been designed and tested in accordance with IEC
Publication 61010-1+A1+A2:1991 Safety Requirements for Electrical
Equipment for Measurement, Control and Laboratory Use and has been
supplied in a safe condition. The instruction documentation contains
information and warnings which must be followed by the user to ensure
safe operation and to maintain the instrument in a safe condition.

The information contained in this document is subject to change without
notice.

Agilent Technologies makes no warranty of any kind with regard to this
material, including but not limited to, the implied warranties of
merchantability and fitness for a particular purpose. Agilent
Technologies shall not be liable for errors contained herein or for
incidental or consequential damages in connection with the furnishing,
performance, or use of this material.

The following safety symbols are used throughout this manual.
Familiarize yourself with the symbols and their meaning before
operating this instrument.

Warning denotes a hazard. It calls attention to a procedure
which, if not correctly performed or adhered to, could result in
injury or loss of life. Do not proceed beyond a warning note until
the indicated conditions are fully understood and met.

Caution denotes a hazard. It calls attention to a procedure that, if not
correctly performed or adhered to, could result in damage to or
destruction of the instrument. Do not proceed beyond a caution sign until
the indicated conditions are fully understood and met.




NOTE

WARNING

WARNING

WARNING

WARNING

Note calls out special information for the user’s attention. It provides
operational information or additional instructions of which the user
should be aware.

This is a Safety Class 1 Product (provided with a protective
earthing ground incorporated in the power cord). The mains
plug shall only be inserted in a socket outlet provided with a
protected earth contact. Any interruption of the protective
conductor inside or outside of the product is likely to make the
product dangerous. Intentional interruption is prohibited.

If this product is not used as specified, the protection provided
by the equipment could be impaired. This product must be used
in a normal condition (in which all means for protection are
intact) only.

No operator serviceable parts inside. Refer servicing to qualified
personnel. To prevent electrical shock do not remove covers.

For continued protection against fire hazard, replace line fuses
only with the same type and ratings (115V range; type F 5A 125V,
239V range F 5A 250V). The use of other fuses or materials is
prohibited.




CAUTION

To prevent electrical shock, disconnect the instrument from the mains
(line) before cleaning. Use a dry cloth or one slightly dampened with
water to clean the external case parts. Do not attempt to clean internally.

Environmental requirements: This product is designed for indoor use
only and to meet the following environmental conditions:

= Operating temperature: 0° C to +55° C
= Operating humidity: <95% relative
= Altitude: up to 4500 m

Warranty

This Agilent Technologies instrument product is warranted against
defects in material and workmanship for a period of three years from
date of shipment. During the warranty period, Agilent Technologies
Company will, at its option, either repair or replace products which prove
to be defective.

For warranty service or repair, this product must be returned to a service
facility designated by Agilent Technologies. Buyer shall prepay shipping
charges to Agilent Technologies and Agilent Technologies shall pay
shipping charges to return the product to Buyer. However, Buyer shall
pay all shipping charges, duties, and taxes for products returned to
Agilent Technologies from another country.

Agilent Technologies warrants that its software and firmware designated
by Agilent Technologies for use with an instrument will execute its
programming instructions when properly installed on that instrument.
Agilent Technologies does not warrant that the operation of the
instrument, or software, or firmware will be uninterrupted or error-free.




LIMITATION OF WARRANTY

The foregoing warranty shall not apply to defects resulting from
improper or inadequate maintenance by Buyer, Buyer-supplied software
or interfacing, unauthorized modification or misuse, operation outside of
the environmental specifications for the product, or improper site
preparation or maintenance.

NO OTHER WARRANTY IS EXPRESSED OR IMPLIED. AGILENT
TECHNOLOGIES SPECIFICALLY DISCLAIMS THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE.

EXCLUSIVE REMEDIES

THE REMEDIES PROVIDED HEREIN ARE BUYER’S SOLE AND
EXCLUSIVE REMEDIES. AGILENT TECHNOLOGIES SHALL NOT
BE LIABLE FOR ANY DIRECT, INDIRECT, SPECIAL, INCIDENTAL,
OR CONSEQUENTIAL DAMAGES, WHETHER BASED ON
CONTRACT, TORT, OR ANY OTHER LEGAL THEORY.

Where to Find the Latest Information

Documentation is updated periodically. For the latest information about
Agilent NFA Noise Figure Analyzers, including firmware upgrades and
application information, please visit the following Internet URL:

http://www.agilent.com/find/nf/




Hersteller-
bescheinigung

Manufacturer’s Declaration

This statement is provided to comply with the requirements of the
German Sound Emission Directive, from 18 January 1991.

This product has a sound pressure emission (at the operator position)
<70 dB(A).

Sound Pressure Lp < 70 dB(A).
At Operator Position.
Normal Operation.

According to 1ISO 7779:1988/EN 27779:1991 (Type Test).

Diese Information steht im Zusammenhang mit den Anforderungen der
Maschinenlarminformationsverordnung vom 18 Januar 1991.

Schalldruckpegel Lp < 70 dB(A).

Am Arbeitsplatz.

Normaler Betrieb.

Nach ISO 7779:1988/EN 27779:1991 (Typprifung).
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Getting Started

This chapter introduces you to basic features of the Noise Figure
Analyzer, including front panel and rear panel descriptions, and an
overview of the display annotation.




Getting Started
What You will Find in this Chapter

What You will Find in this Chapter

This chapter covers the following:

The Noise Figure Analyzer Features
Overview of the Front Panel
Overview of the Rear Panel

Display Annotation

Overview of the Front Panel Keys
Performing Common File Operations

Working with Tables

Chapter 1
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The Noise Figure Analyzer Features

The Noise Figure Analyzer Features

3.0 GHz Mechanical Switch

The N8974A and N8975A NFA models have a mechanical switch fitted to
allow them to switch between the 10 MHz to 3.0 GHz frequency range
and the 3.0 GHz to 6.7 GHz and the 3.0 GHz to 26.5 GHz frequency
ranges respectively. If the frequency range you are working in crosses the
3.0 GHz point, the mechanical switch operates. The mechanical switch
has a limited number of cycles over which it is reliable.

To maximize the switches reliable life, switching over the 3.0 GHz switch
should be limited where possible.

Microwave Front Panel Connector

The N8974A and N8975A NFA models are fitted with a precision 3.5mm
male input connector. The models are supplied with a Precision 3.5mm
Coaxial Adaptor (83059B) and a 3.5mm Spanner (8710-1933). When
making connection you need to ensure you apply the correct torque and
you use the adaptor where needed. Correct torque value guidance is in
the Agilent NFA Series Performance Verification and Calibration
Guide.

Chapter 1 3
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Overview of the Front Panel

Overview of the Front Panel

Figure 1-1 Front Panel Overview
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Table 1-1 Front Panel Item Descriptions
Item Description
1 Viewing Angle keys allow you to adjust the display.
2 The Esc (escape) key cancels any entry in progress.
3 Menu keys are the unlabeled keys next to the screen. The menu
key labels are shown on the display next to these unlabeled keys.

4 Chapter 1



Table 1-1

Getting Started

Overview of the Front Pane

Front Panel Item Descriptions

Item

Description

4

The MEASURE functions allow you to configure the NFA
parameters needed for making measurements.

TheFrequency/Points and Averaging/Bandwidth keysactivate
the primary set up function menu keys.

The Calibrate key removes any second stage noise contribution
from the measurement. The ENR key accesses the ENR menu.

TheMeas Mode and Mode Setup keysare used to configure the
NFA to measure mixers and devices at frequencies greater than
the basic frequency of the NFA using aLocal Oscillator.

The DISPLAY functions alow you to configure the display
results.

The CONTROL functions allow you to setup the NFA's
advanced features.

SYSTEM functions affect the state of the NFA. Various setup
and alignment routines are accessed with the System key.

The greerPreset key resets the NFA to a known state.

TheFile key menu allows you to save and load the various N
file types and access the File Manager. Taee Trace key
executes th&ave function defined undefile.

ThePrint Setup menu keys allow you to configure hardcopy
output. ThePrint key sends hardcopy data to the printer.

FA

The Media Door on the right side of the front panel accesse
3.5 inch disk drive.

5 the
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Getting Started

Overview of the Front Panel

Front Panel Item Descriptions

Item

Description

9

The Data Entry Keys, which include the Up/Down arrow keys,
RPG (rotatable knob), and numeric keys, allow you to enter or
change the numeric value of an active function.

The Numeric Keys alows entry of exact values for many of the
NFA functions. To terminate a numeric, where no unit labels
have been presented, press the Enter key.

The RPG allows continuous change of functions such as marker
position.

The Up/Down arrow keys allow discrete increases or decreases
of the active function value.

10

Not currently supported.

11

PROBE POWER provides power for other accessories.

12

The [ Prev key accesses the previously selected menu.

13

NOISE SOURCE DRIVE OUTPUT +28V PULSED this
connector provides a28 Vdc level to switch the noise source on.
The noise source is off when no voltage is applied.

14

Tab Keys are used to move between, table input fields, fields on
forms, and to move within the fields of the dialog box accessed
by the File menu keys.

15

INPUT 50Q Thisisthe input connector for the NFA.
N8972/3A models have a Type-N connector.
N8974/5A models have a precision 3.5 mm connector.

16

The Next Window key selects which graph or result
parameter is active.

Pressing Zoom key while in graph mode allows you to
switch between the dual-graph and single-graph display.

17

Pressthe Help key and then any front panel or menu key to get a
short description of the key function and the associated remote
command.

Chapter 1
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Table 1-1 Front Panel Item Descriptions
Item Description
18 The Smart Noise Source (SNS) connector providesthe interface

to upload the ENR data, monitor the ambient temperature, and
switch the SNS off and on.

19 The [On) key turns the NFA on, while the O (Standby) key
switches the NFA to standby.

Chapter 1
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Overview of the Rear Panel

Figure 1-2 Rear Panel Overview
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Table 1-2 Rear Panel Item Descriptions
Item Description
1 Power input isthe input for the AC line-power source.
2 Line Fuse. The fuseis removed by twisting counterclockwise
1/4 turn. Replace only with afuse of the same rating. See the
label on the rear panel and information in the Setup Guide.
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Overview of the Rear Panel

Table 1-2 Rear Panel Item Descriptions

Item Description

3 Service Connector. The service connector isfor service use only.

4 VGA OUTPUT drives an external VGA compatible monitor with
asignal that has 31.5 kHz horizontal, 60 Hz vertical
synchronizing rate, non-interlaced.

5 PARALLEL interface port isfor printing only.

6 RS-232 interface supports remote instrument operation.

7 Presel Tune Connector it ishot currently supported.

8 10 MHz REF IN accepts an external frequency source to provide
the 10 MHz, —15 to +10 dBm frequency reference used by the
NFA.

9 10 MHz REF OUT provides a 10 MHz, 0 dBm minimum,
timebase reference signal.

10 LO GPIB port is for the control of an external LO by the NFA.

11 MAIN GPIB interface port supports remote instrument operation.

12 AUX OUT (TTL) it isnot currently supported.

13 AUX IN (TTL) it is not currently supported.

14 Power On Selection selects an instrument power preference.

Chapter 1 9
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Overview of the Front Panel Keys

How the Front Panel Keys are Organized
The front panel keys are divided into four main groups:

= MEASURE keys, which are used to configure the measurement
parameters

= CONTROL keys, which are used to configure advanced measurement
parameters

= SYSTEM keys, which perform system-level operations

= DISPLAY keys, which adjust the display characteristics of the
measurement

Navigating Through the Menu System

Menu keys Pressing any of the grey front panel keys in the MEASURE, DISPLAY,
RESULT or SYSTEM key groupings accesses menus of functions that are
displayed along the right-hand side of the display. These keys are called
menu keys. See Figure 1-3.

10 Chapter 1



Figure 1-3

Action keys

To activate a menu
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Selecting a
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Getting Started
Overview of the Front Panel Keys
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Pressing any of the white keys (Calibrate, Full Screen, Restart, Save Trace
and Print) invokes an action and these keys are called action keys.

To activate a menu key function, press the key immediately to the right
of the screen menu key. The menu keys that are displayed depend on
which front panel key is pressed and which menu level or page is
selected.

Some menu keys have functions contained within them, for example, On
and Off. To turn the function on, press the menu key so that On is
underlined. To turn the function off, press the menu key so that Off is
underlined.

For a summary of all front panel keys and their related menu keys, see
the User’s Guide or the analyzer online help.
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Display Annotation

The display annotation, shown in Figure 1-4, is referenced by numbers.
Table 1-3 has a description and, where appropriate, a function key
indicating which key activates the function related to the annotation.

Figure 1-4 Display Annotation
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Display Annotation

Each item is given a description and where applicable a function key
associated with it.

Table 1-3 Display annotation item descriptions
Item Description
1 The active function area displays the label and value of the

currently active key.

2 The time and date display, controlled by the Time/Date menu
key, under the System key menus.

3 The marker numbers are displayed in this column, each row
displays the markers results. It is controlled by the Marker and
the State menu keys.

4 The markers frequency is displayed in this column. Itis
controlled by the Marker and the State menu keys.

5 The upper trace measurement result is displayed in this column.
It is controlled by either the Result, Marker, State menu keys.

6 The lower trace measurement result is displayed in this column.
It is controlled by either the Result, Marker, State menu keys.

7 The GPIB annunciators RLTS.

8 The datainvalid indicator appears when a measurement starts. It
disappears after a complete sweep.

9 The key menutitle, thisis dependent on which key is selected.
10 The key menu.
11 The frequency span or stop frequency, controlled by the

Freq Span or Stop Freq key.

12 Displays the measurement correction state, uncorrected or
corrected. Controlled by the calibration state and the Corr key.

13 Displays the Loss Compensation status, On or Off. Controlled
by the Loss Comp key.

14 The number of points, controlled by the Points menu key.

Chapter 1 13
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Display Annotation

Table 1-3 Display annotation item descriptions
Item Description
15 Displays the value of attenuation being applied. The left itemis

the RF attenuator and the right item is the microwave attenuator.
On the N8972/3A only the RF attenuator status is displayed.

16 The bandwidth, controlled by the Bandwidth menu key.
Thisisfixed at 4 MHz on the N8972A model.

17 The number of averages, controlled by the Averages menu key.

18 The center frequency or start frequency, controlled by the
Center Freq or Start Freq menu keys.

19 The T, g temperature value, controlled by the Tcold menu key.

20 The display status line, displays instrument status and error
messages.

21 Thelower trace lower limit, controlled by the Lower Limit menu
key.

22 The lower trace unit of measurement on the Y-axis, controlled

by the Result key or Scale menu key.

23 The lower trace scale, controlled by the Scale/Div menu key.

24 The lower trace result type, controlled by the Result key.

25 The lower trace upper limit, controlled by the Upper Limit menu
key.

26 The upper trace lower limit, controlled by the Lower Limit menu
key.

27 The upper trace unit of measurement on the Y-axis, controlled

by the Result key or Scale menu key.

28 The upper trace scale, controlled by the Scale/Div menu key.

29 The upper trace result type, controlled by the Result key.

30 The upper trace upper limit, controlled by the Upper Limit menu
key.

14 Chapter 1



Getting Started
Display Annotation

Table 1-3 Display annotation item descriptions
Item Description
31 The limit line failure indicator.
Shownin The measurement mode status, controlled by the Meas Mode
Figure 1-5 key. Thisinformation is displayed by default. The status
disappears when the marker results are switched on.

Figure 1-5 Measurement Mode Status

DUT Amplifi ff

Basic Setup Measurement Mode

Using a Converter Measurement Mode
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Performing Common File Operations
This section covers:

= Formatting a diskette
= Saving a file

= Loading a file

< Renaming a file

= Copying a file

= Deleting a file

Formatting a Diskette

The format is MS-DOS. It is not necessary to format your diskette with
the NFA; pre-formatted disks can be used with the NFA.

Step 1. Place the diskette you wish to format into the diskette drive (A:) of the
NFA.

Step 2. Access the file manager menu by pressing File key, File Manager. See
Figure 1-6.
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Figure 1-6
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Performing Common File Operations

File Manager Menu

- Agilent | File Manager

Copy»
Deleter

Rename»

Format»

Step 3. Start the format process by pressing Format, then Enter.
Step 4. Press Enter, a second time to format the disk.
The format process takes approximately three minutes.

You are now ready to save files to the disk.

Chapter 1 17
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NOTE

Step 6.

Getting Started
Performing Common File Operations

Saving a File

You can save files (ENR tables, states, traces, limits, frequency lists, loss
tables, or screens) to a floppy disk (A: ), or the internal drive (C. ) of the
NFA.

To access the Save menu press File, Save.
Select the type of file you want to save.

For example, if you have limit line table data present and want to save it,
press Limits.

Select the limit line table file you wish to save (1, 2, 3 or 4).
For example, to save file 2, press 2.
Enter a filename using the Alpha Editor menu keys.

Select the drive you wish to save to by pressing Tab -, to move to
directory and file list, press Select.

If the correct drive is not listed in the Pat h: field, highlight “..”  at the
top of the directory list. This enables you to move up a directory. Press
Select. To highlight the desired drive,[-A] or [-C-] ) use the arrow keys
or the RPG, press Select when highlighted.

Press Enter, to save the file to the drive.

18 Chapter 1
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Step 5.

Getting Started
Performing Common File Operations

Loading a File

You can load files (ENR tables, states, limits, frequency lists, or loss
tables) from a floppy disk (A: \), or the internal drive (C\).

Not all the file types you save can be loaded back into the NFA. For
example, screen files and trace files. The trace file is in a CSV (comma
separated value) format, designed for use with a PC.

To access the Load menu press File, Load.

Select the type of file you want to load (ENR tables, states, limits,
frequency lists, or loss tables).

Select the drive where your file is located by pressing Tab -. Use the
RPG to highlight [ - C-] or [ - A-], then press Select.

Select the file you want to load into the NFA by changing the highlighted
file with the up or down arrow keys to highlight the file name.

Press Enter to load the specified file.

Renaming a File
You can rename a fileinthe [-CG ] or[-A-] drive as follows:
Press File, File Manager, Rename to access the Rename menu items.

Select the type of file you want to rename (ENR tables, states, traces,
limits, frequency lists, loss tables, or screens).

For example, if you are renaming a ENR table file, press ENR.

Select the drive where your file is located, by pressing the Tab - key,
press Select. To change drive, use the arrow keys to highlight [ - C-] or
[ - A-], then press Select.

Select the file you want to rename by moving the cursor with the RPG or
arrow keys to highlight the file name.

Press Tab - to enter the Alpha Editor menu. File names are limited to
eight (8) characters.

Chapter 1 19
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Getting Started
Performing Common File Operations

Press Enter and your file is now renamed and visible within the directory
displayed on your NFA.

Copying a File

This allows you to copy a file to a different location on both the [ - G ]
and [ - A-] drive.

To access the Copy menu press File, File Manager, Copy.
Put a formatted floppy in the A: drive.

Select the type of file you want to copy (ENR tables, states, traces, limits,
frequency lists, loss tables or screens).

For example, if you are copying a State file, press State.

Select the drive where your file is located, by pressing Tab — to highlight
the From Pat h: field. Select the drive, using the RPG or arrow keys to
highlight [ -G ] or [ - A-], then press Select.

Select the file you wish to copy by highlighting the filename using the
front-panel knob or arrow keys.

Press Tab — to move to the To: Pat h: field and select the drive where you
want to copy the file using the RPG or arrow keys then press Select.

If the correct drive is not listed in the Pat h: field, highlight “..”  at the
top of the directory list. This enables you to move up a directory. Press
Select, to highlight the desired drive, ([-A] or [-C-] ) then press Select
again.

Copy the file by pressing Enter.

20 Chapter 1
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Deleting a File
This allows you to delete a file from the [ -G ] or [ - A-] drive.
To access the Delete menu press File, File Manager, Delete.

Select the type of file you want to delete (ENR tables, states, traces,
limits, frequency lists, loss tables, or screens).

Select the drive where the file you wish to delete is located, by pressing
Tab - then using the RPG or arrow keys to highlight[-C-] or[-A-],
then press Select.

If the correct drive is not listed in the Pat h: field, highlight “..”  at the
top of the directory list. This enables you to move up a directory. Press
Select, to highlight the desired drive, ([-A] or [-C-] ) then press Select
again.

Select the file you want to delete by moving the cursor with the RPG or
arrow keys to highlight the file name.

Press Enter and your file is now deleted and is no longer visible in the
directory displayed on your NFA.
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Table 1-4

Getting Started

Working with Tables

Working with Tables

The Frequency List, ENR Table, Limit Line Editor, and Loss

Compensation Tables use table forms. The following is an overview of
how to use the features in these tables.

Using Tables
To... Usethe...
Move the highlight bar within the table | Tab keys
Bring the highlight bar to the top of the | Home key

table

Clear the table of all entries

Clear Table menu key

Delete asingle row entry

Delete Row menu key

Add anew entry

Add menu key

Move the highlight bar up one row

Row Up menu key

Move the highlight bar down one
row

Row Down menu key

Move the table up a page block

Page Up menu key

Move the table down a page block

Page Down menu key

Enter avalue

Numerical key pad

Terminate avalue

The unit values presented by the
menu keys?

Connect Limit Line points

The arrow keys or the RPG

a. A limit linevalueisaunitless value and it depends on the result's

scale unit used.
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Making Basic Measurements

This chapter describes how to make basic noise figure measurements
using your NFA and also covers the most common measurement related
tasks.

23



Making Basic Measurements
What You will Find in this Chapter

What You will Find in this Chapter

This chapter covers.

Entering Excess Noise Ratio (ENR) Data
Setting the Measurement Frequencies
Setting the Bandwidth and Averaging
Calibrating the Analyzer

Displaying the Measurement Results

24

Chapter 2



Figure 2-1

Making Basic Measurements
Entering Excess Noise Ratio (ENR) Data

Entering Excess Noise Ratio (ENR) Data

You can enter ENR data for the noise source you are using as a table of
values or as a single spot value. The table of values are used for
measurements at several frequencies. The single spot value is used for
single frequency measurements or it is applied across the whole
frequency measurement range.

There are two types of noise source. The first type, for example,
Agilent 346B, a normal noise source. These need their ENR data to be
entered manually either using the ENR data stored previously on a
diskette or by using the keypad. The other type, for example,

Agilent N4000OA, a Smart Noise Source (SNS), can upload the data
automatically or when requested.

Selecting a Common ENR Table

To use the same ENR table for calibration and measurement, press the
Common Table menu key to select Common Table(On); see Figure 2-1.

This is the default setting. In this mode the Cal Table is not accessible.

Menu Keys showing Common ENR Table On

Common Table
0ff On

ENR Table»
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Making Basic Measurements
Entering Excess Noise Ratio (ENR) Data

To use different ENR tables for calibration and measurement, press the
Common Table menu key to select Common Table(Off); see Figure 2-2.

In this mode, the Cal Table menu key is accessible. This is the ENR table
of the noise source used to calibrate the NFA. The Meas Table is used to
make measurements. In Common Table(Off) mode the ENR Table is the
Meas Table in the Common Table(On) mode.

Figure 2-2 Menu Keys showing Common ENR Table Off

Common Table
0ff On

Meas Tabler

Cal Tabler

NOTE If you are using an SNS when Common Table(Off) is set, you need to set
Auto Load ENR(Off) and use the Fill Table From SNS menu key. See
“Loading the SNS ENR data to the Measurement or Calibration Table.”
on page 33.

Entering ENR Table Data for Normal Noise Sources

You can enter ENR data in the form of an ENR table in four ways:

< manually by inputting the required frequencies and corresponding
ENR values

= loading the ENR data from a diskette, on which the data has been
previously stored

= loading the ENR data from the internal memory, where the data has
been previously stored

= loading the ENR data over GPIB, see the Programmer’s Reference
for more details
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Figure 2-3

Step 1.

Step 2.

Step 3.

Step 4.

Step 5.

Step 6.

Making Basic Measurements
Entering Excess Noise Ratio (ENR) Data

To enter ENR table data manually

Press the ENR key, and the ENR Table menu key.

An Empty ENR Table

Edit Table»
ENR Table
Frequency ENR Yalue Serial Number»
Noise Source Serial Number | T
— — — ID»
Noise Source Model ID - - Fill Table
Fram SN

I ENR Table

Use 'File' key to Load or Save a table.

Optional Step

Press the Serial Number menu key and enter the noise source serial
number using the numeric keys and the Alpha Editor.

Optional Step

Press the ID menu key and enter the noise source model number using
the numeric keys and the Alpha Editor.

Press the Edit Table menu key to enter the noise source ENR values.

Enter the frequency value in the table using the numeric keys.
Terminate it using the unit menu keys.

Press the Tab —> key to move the highlight to the ENR Value column and
enter the corresponding ENR value of the ENR list.

When terminating the ENR value you can use either dB, K, C, or F menu
keys. The K, C, or F entry is converted to appear in the table as dB.
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Step 7.

Step 8.

Step 9.

Step 10.

NOTE

Figure 2-4

Making Basic Measurements
Entering Excess Noise Ratio (ENR) Data

Press the Tab —> key to move the highlight to the Frequency column and
enter the next frequency value on the ENR list.

Repeat steps 5 to 7 until all the frequency and ENR values you need are
entered.

After completing the ENR table entries, press the Prev key or ENR key to
return to the ENR menu.

Optional Step

Once you have completed entering the ENR data, save the ENR table
using the File key.

ENR table data survives a power cycle and preset (except
Restore Sys Defaults ). You only need to save the ENR data to save you
from entering the data again.

A Typical ENR Table after data entry

= Agilent Edit Table
ENR Value 15.400 dB
] Row Up
ENR Table
Frequency ENR Value Row Down
. . 10.0000000 MHz | 15.330 dB
Noise Source Serial Number 100000000 MH= | | 15.560 dB
[3318A14197 1.00000000 GHz | 15.360 dB Page Up
2.00000000 GHz | 15.120 dB
3.00000000 GHz | 14.970 dB
Noise Source Model ID 400000000 GHz || 14.91@ dB Page Down
5.00000000 GHz | 14.850 dB
346B 6.00000000 GHz | 14.900 dB
700000000 GHz | 14.860 dB Add
3.00000000 GHz | 14.890 dB
9.00000AR0 GHz | 15.010 dB
10.0000000 GHz | 15.110 dB
11.0000000 GHz | 15.260 dB Delete Row
12.0000000 GHz | 15.400 dB
13.0000000 GHz | 15.440 dB
lse ‘File' key to Load or Save a table. Clear Table
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Step 1.

Step 2.
Step 3.
Step 4.
Step 5.

Step 6.

Step 1.
Step 2.
Step 3.
Step 4.

Step 5.
Step 6.

Step 7.

Making Basic Measurements
Entering Excess Noise Ratio (ENR) Data

To load ENR data from memory

If the ENR file is on diskette, insert the diskette into the floppy drive of
the NFA.

Press the File key.

Press the Load menu key to access the file system.
Press the ENR menu key.

Press either the Meas Table or Cal Table menu key.

A list of available files on the [ - A-] or [ - G ] drive is displayed. Use the
arrow keys to access the appropriate file.

Press the Enter key.

Saving an ENR Table

You can save an ENR table to the NFA's internal memory or to floppy
disk as follows:

Press the File key.
Press the Save menu key.
Press the ENR menu key.

Press either the Meas Table or Cal Table menu key. Also, if you are using
an SNS, an SNS menu key is available to select.

The Alpha Editor now appears, allowing you to create a name for the file.
Input the name of the ENR table.

Select using the arrow keys whether you want to save the files to the
[-A] or[-C] drive.

Press Enter to save the file.
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Step 1.
Step 2.
Step 3.

NOTE

Step 1.
Step 2.

Making Basic Measurements
Entering Excess Noise Ratio (ENR) Data

Entering a Spot ENR Value

To enter a Spot ENR value:

Press the ENR key, then the Spot menu key.
Press the Spot ENR menu key.

Enter an ENR value using the numeric keys and terminate it using the
unit termination menu keys. The default value is 15.20 dB.

If you are using a noise source with a calibrated ENR list and the
frequency you want to measure is not a listed ENR value, then you need
to interpolate the ENR list to an appropriate value.

To Enable Spot ENR Mode
Press the ENR key, and select the ENR Mode(Spot) menu key.

Press the Spot menu key, and select the Spot Mode(ENR) menu key.
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Making Basic Measurements
Entering Excess Noise Ratio (ENR) Data

Entering a Spot T}, Value
To enter a Spot T, value:

Step 1. Press the ENR key, then the Spot menu key.
Step 2. Press the Spot Thot menu key.

Step 3. Enter a Ty Value using the numeric keys and terminate it using the
unit termination menu keys. The default value is 9892.80 K.

To Enable Spot Thot Mode
Step 1. Press the ENR key, and select the ENR Mode(Spot) menu key.

Step 2. Press the Spot menu key, and select the Spot Mode(Thot) menu key.
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Step 1.
Step 2.
Step 3.
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Making Basic Measurements
Entering Excess Noise Ratio (ENR) Data

Using a Smart Noise Source

If there is an SNS connected to the NFA's Smart Noise Source port, the
NFA, by default, selects the SNS as its noise source. If an SNS is not
connected the NFA uses the normal noise source.

Selecting the Source Preference

If noise sources are connected to both ports you need to select a
preference either Preference(Normal) or Preference(SNS). The default
setting is Preference(SNS).

To select a noise source preference:
Press the ENR key.
Press the SNS Setup menu key.

Press the Preference menu key changing it from the default
Preference(SNS) to Preference(Normal).

Loading the SNS ENR data to the Common Table.

You can enable the NFA to automatically upload the ENR data to the
Common Table. To enable automatic loading on power up or the
connection of the SNS to the NFA's Smart Noise Source port, set

Auto Load ENR(On). This enables the ENR data to load into the Common
Table automatically. If you do not want to automatically upload the ENR
data into the Common Table, press Auto Load ENR(Off).

If you have selected Auto Load ENR(Off), you can use the

Fill Table From SNS menu key to upload the ENR data from the SNS. The
Fill Table From SNS menu key is found under the ENR Table menu key. It is
only active when an SNS is connected. This allows you to choose when to
upload the ENR data to the ENR Table.

Do not disconnect the noise source from the NFA port while the data is
being transferred.
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Step 1.
Step 2.
Step 3.
Step 4.
Step 5.
Step 6.

CAUTION

Making Basic Measurements
Entering Excess Noise Ratio (ENR) Data

Loading the SNS ENR data to the Measurement or Calibration
Table.

When an SNS is connected and Auto Load ENR(On) enabled, the
Common Table(On) is set automatically. Hence, the SNS ENR data is
loaded into the common ENR table.

You can use the Fill Table From SNS menu key to upload the ENR data
from the SNS. This allows you to choose between Meas Table or Cal Table,
as the destination for the ENR data.

Press the ENR key.

Press the SNS Setup menu key.

Press the Auto Load ENR menu key setting it to Auto Load ENR(Off).
Press the Common Table menu key setting it to Common Table(Off).
Press the Meas Table or Cal Table menu key.

Press the Fill Table From SNS menu key and wait until all the data is
uploaded.

Do not disconnect the noise source from the NFA port while the data is
being transferred.
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Step 1.
Step 2.

NOTE

Step 3.

Making Basic Measurements
Entering Excess Noise Ratio (ENR) Data

Setting the T,y 4 Value

When making measurements in different ambient temperature
conditions you can change the T, 4 value.

The default temperature value is set at 296.50K. The T, 4 menu key is
set to Tcold(Default) to confirm this default temperature.

There are three methods of changing the T4 value. These are
dependant on the type of noise source you are using.

= The first method is applicable when using either type of noise source
and allows you to enter a T, 4 value manually. This method is

explained in “Changing the User Tcold value manually” on page 34.

= The second method is applicable when using the SNS noise source
and it uploads the value automatically and updates the value after
every sweep. This method is explained in “Setting the SNS Tcold
value to Update Automatically” on page 35.

= The third method is applicable when using the SNS where you can set
the value to be updated as you need. This method is explained in
“Setting the SNS User Tcold value” on page 36.

Changing the User T.q g value manually
To change the User Ty 4 Value:

Press the ENR key.

Press the Tcold menu key.

When using an SNS, the SNS Tcold menu key must set to SNS Tcold(Off)
for this feature to work.

Press the User Tcold menu key setting it from the default User Tcold(Off)
to User Tcold(On).

The Tcold menu key, under the ENR menu keys, is now set to Tcold(User)
to confirm you are using this temperature mode.
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Step 4.

Step 1.
Step 2.
Step 3.

Making Basic Measurements
Entering Excess Noise Ratio (ENR) Data

Press the User Value menu key.

Enter a T4 value using the numeric keys and terminate it using the
unit termination menu keys.

The unit termination menu keys are in K (Kelvin), C (Celsius) or
F (Fahrenheit).

Setting the SNS T4 value to Update Automatically

This feature is only available when an SNS is connected to the NFA.
To set the SNS T4 value:

Press the ENR key.

Press the Tcold menu key.

Press the SNS Tcold menu key, if required, setting it to SNS Tcold(On).

The Tcold menu key, under the ENR menu keys, is now set to Tcold(Auto)
to confirm you are using this temperature mode.
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Making Basic Measurements
Entering Excess Noise Ratio (ENR) Data

Setting the SNS User T Value

This feature only works when an SNS is connected to the NFA.
To change the User Ty 4 Value:

Press the ENR key.

Press the Tcold menu key.

When using an SNS, SNS Tcold must set to SNS Tcold(Off) for this feature
to work.

Press the User Tcold menu key changing it from the default
User Tcold(Off) to User Tcold(On).

Press the User Tcold From SNS menu key.

The NFA uploads the Tcold value from the SNS and displays the value in
the User Value menu key.

The Tcold menu key, under the ENR menu keys, is now set to Tcold(User)
to confirm you are using this temperature mode.
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Step 1.
Step 2.

Step 3.
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Setting the Measurement Frequencies

Setting the Measurement Frequencies

Three frequency modes are available:

= Sweep — the measurement frequencies are obtained from the start
and stop (or equivalent center and span) frequencies and the number
of measurement points.

= List — the measurement frequencies are obtained from the frequency
list entries.

= Fixed — where the measurement frequency is taken at a single fixed
frequency.

Selecting Sweep Frequency Mode

The N8974A and N8975A NFA models have a mechanical switch fitted to
allow them to switch between the RF frequency range and the microwave
frequency range. If the frequency range you are working in crosses the
3.0 GHz point, the mechanical switch operates. The mechanical switch
has a limited number of cycles over which it is reliable.

Switching over the 3.0 GHz switch should be limited where possible.

You can press Full Span at anytime to return the frequency range to the

specific NFA model’s full range setting. If you do this after a calibration

and the calibration has been made over a narrower frequency range, the
calibration is invalid.

Press the Frequency/Points key.

Press the Freq Mode menu key to select frequency mode to
Freq Mode(Sweep).

Set the frequency range by either entering the Start Freq and Stop Freq
frequencies, or the Center Freq and the Freq Span.
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Setting the Measurement Frequencies

Step 4. Press the More 1 of 2, Points menu keys.

Step 5. Enter the number of measurement points using the numeric keys. Press
the Enter key to terminate.

Selecting List Frequency Mode
To set the NFA to use the data in the frequency list table:
Step 1. Press the Frequency/Points, Freq Mode menu keys.
Step 2. Press the Fixed menu key to set the frequency mode to Freq Mode(List).
You can create a frequency list in the following ways:
= Manually, by specifying each individual point.

= From the swept points, by specifying the measurement frequency
range and setting the NFA to generate equally spaced points within
that range, using the Fill menu key.

= Loading a list from the internal memory or diskette, where the data
has been previously stored.

= Loading a list over GPIB; see the Programmer’s Reference if you
want to use this method.

To Create a Frequency List Manually
Step 1. Press the Frequency/Points key and press the More 1 of 2 menu key.

Step 2. Press the Freq List menu key.
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Figure 2-5

NOTE

An Empty Frequency List

Freq List
Froquny —

Freqguency List

Use 'File' key to Load or Save a table.

Frequency

Making Basic Measurements

Setting the Measurement Frequencies

Row Up

Row Down

Page Up

Page Down

Add

Delete Row

Hore’
lof2

Step 3. Press the More 1 of 2, Clear Table menu keys.

Step 4. Enter the frequency value you want using the numeric keys. Terminate

it using the unit menu keys which are presented to you.

Step 5. Press the Tab —> key or Row Down menu key.

Enter the next frequency value by using the numeric key pad and the

unit termination keys.

Step 6. Repeat step 5 until your list is complete.

Step 7. Save the Frequency List to the NFA internal memory or to a diskette if

required using the File key. See “Saving a File” on page 18 for an

explanation of this.

If you do not save the frequency list, you may lose the data. This depends

on your Power On/Preset condition.

Chapter 2
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Creating a Frequency List from Swept Points

You can create a frequency list from the swept mode frequency and
points data.

To set the NFA to use the swept mode data:

Press the Frequency/Points, More 1 of 2 menu keys.

Press the Freq List, More 1 of 2 menu keys.

Pressing the Fill menu key.

This clears the current frequency list and fills the list with the
frequencies generated by the sweep frequency mode.
Selecting Fixed Frequency Mode

The fixed frequency mode is used when you want to make a
measurement at a single frequency.

To set a fixed frequency:

Press the Frequency/Points, Freq Mode menu keys.

Press the Fixed menu key to set the frequency mode to Freq Mode(Fixed).
The Fixed Freq menu key is now available.

Press the Fixed Freq menu key and enter the frequency value using the
numeric keys and the unit termination menu keys.
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Setting the Bandwidth and Averaging

Setting the Bandwidth and Averaging

Selecting a Bandwidth Value

Press the Averaging/Bandwidth key.
The current bandwidth is shown on the Bandwidth menu key.

Press the Bandwidth menu key and select the bandwidth you want from
the list of available options.

On the N8972A model, the bandwidth menu key is unavailable. The
bandwidth is fixed at 4AMHz.

Setting Averaging

Increased averaging reduces jitter and provides more accurate
measurement results. However, the measurement speed is sacrificed.

Averaging can be enabled by setting the Averaging(On). To disable
averaging set Averaging(Off)

Setting the Number of Averages
Press the Averaging/Bandwidth key, and then the Averages menu key.

Enter the numeric value you want using the numeric key pad. Terminate
it with the Enter key.

Selecting the Averaging Mode

Averaging Mode can be set to Average Mode(Point) or
Average Mode(Sweep).
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Step 2.
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Calibrating the Analyzer

Calibrating the Analyzer

To compensate for the noise contribution of the NFA, the associated
cabling, and so forth in the measurement path, a calibration is necessary.

To perform calibration you need to enter the ENR values and set up the
frequency range, number of measurement points, the bandwidth, the
averaging, and measurement mode to be used during the measurement.
For more details on calibration, such as when to perform calibration and
when calibration is invalidated and so forth, see the User’s Guide.

To perform a calibration

Verify that the correct ENR table is loaded in the NFA, or input the ENR
values of the noise source into the NFA.

See “Entering Excess Noise Ratio (ENR) Data” on page 25 for more
details.

Configure the measurement parameters (frequency range, number of
points, bandwidth, averages, and measurement mode) you want to use
for the measurement.

Connect the noise source output directly to the NFA input.

If you are following this procedure using an N8974A or an N8975A
models care needs to be taken when connecting the precision 3.5 mm
connector by applying the correct torque. For an explanation of the
connectors and guidance on the correct torque values, see the
Performance Verification and Calibration Guide.
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Figure 2-6

NOTE

Step 4.

Step 5.

Making Basic Measurements
Calibrating the Analyzer

NFA Calibration with Normal Noise Source

o
Noise Source ° ]
000 000 o
- T o o ®) )
J

You may need to use connector adaptors to connect the noise source
output to the NFA input during calibration. The connectors you use need
to be included in the measurement. If you remove the connectors from
the measurement you need to apply Loss Compensation to compensate
for any loss caused by the connectors removal. See “Using Loss
Compensation” on page 67 for an explanation of this.

If required select an input attenuator range by pressing the Corr key and
the Input Cal menu key to set the minimum and maximum input
attenuation.

See “Selecting the RF Input Attenuation Range” on page 44 for more
details on input attenuation.

Press the Calibrate key twice to initiate the calibration.
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Step 1.
Step 2.
Step 3.

Making Basic Measurements
Calibrating the Analyzer

Selecting the RF Input Attenuation Range

When measuring a high-gain device you may need to increase the input
attenuation. If you do not know the gain of the DUT, you can perform
calibration using the default range, note what error codes are presented
and then calibrate again using increased attenuation value. The
attenuation value is indicated on the display. If the NFA continues to
display error codes, there is a need to add external attenuator pads and
correct for this attenuation using the Loss Compensation feature. For an
explanation of how to use the feature, see “Using Loss Compensation” on
page 67.

If an error message occurs while calibrating, you need to recalibrate. For
a complete list of error codes see the User’s Guide.

To select the RF input attenuation:
Press the Corr (Corrected) key.
Press the Input Cal menu key and select the attenuation range you want

Set the attenuator range using the Min RF Atten and Max RF Atten menu
keys, and select the attenuation values you want from the list.

Selecting Microwave Input Attenuation Range

The N8974A and N8975A models have a microwave frequency range.
When working in the microwave frequency range of 3.0 GHz to 26.5 GHz,
the NFA has a default input attenuation for calibration of 0dB. Unlike
the RF attenuators, the microwave attenuators cannot autorange.
Therefore there is a risk of overdriving the instrument. In most cases
0dB attenuation is adequate. A guide to the input powers that each
range can handle can be seen in Table 2-1.

Power Detection and Ranging

Attenuation | Maximum Input Approximate DUT Characteristics
Power
0dB -30dBm Combined NF and Gain of DUT

<25dB over full bandwidth

15dB -20dBm Combined NF and Gain of DUT
<35dB over full bandwidth
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Power Detection and Ranging

Attenuation | Maximum Input Approximate DUT Characteristics
Power
30dB -10dBm Combined NF and Gain of DUT
<45dB over full bandwidth

To select the microwave input attenuation:
Press the Corr (Corrected) key.
Press the Input Cal menu key and select the attenuation range you want

Set the attenuator range using the Min JW Atten and Max W Atten menu
keys, and select the attenuation values you want from the list.

Setting the Microwave Input Attenuation after a Calibration

The microwave attenuators cannot autorange. Hence, when making a
microwave measurement you must manually set the microwave input
attenuation to avoid overdriving the NFA. To set the microwave input
attenuation:

Press the Sweep key.
Press the Manual Meas, More 1 of 2 menu key.

Press the Fixed UW Att menu key and select the attenuation range you
want.

Press the More 2 of 2 menu key.

Press the RF/MW Atten menu key to enable RF/PW Atten(Fixed).

If you want to set the RF input attenuation, “Setting the Microwave
Input Attenuation after a Calibration” procedure can be applied to RF
input attenuation. The procedure is similar except you need to substitute
Fixed RFAtt in Step 3.

Chapter 2 45



NOTE

Step 1.
Step 2.

Making Basic Measurements
Displaying the Measurement Results

Displaying the Measurement Results
The following display format features are available:

= Graph, Table or Meter mode display

= Single or dual-graph display allowing any two available result types
to be displayed simultaneously

= Zoom to display only one result graph on the display

= Combine option to display two result types on the same graph
= Markers for searching the trace

= Display an active trace, a memory trace, or both

= Save the current active trace data to memory

= Switch the graticule on or off

= Switch display annotation on or off

If the NFA's display has been previously disabled in Remote mode, you
need to press the System (LOCAL) key to activate the display.

Selecting the Display Format

You can display the measurement results in either:
= Graph format

= Table format

= Meter format

To set the display format:

Press the Format key.

Press the Format menu key and select the Graph, Table or Meter menu key
to select the display mode you want.
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Active Graph

Figure 2-7

Changing the
Active Graph

NOTE

Viewing the Full
Screen

Making Basic Measurements
Displaying the Measurement Results

Navigating Around the Display

The active graph is highlighted by a green border. Noise Figure is the
active graph by default.

Dual-graph display

5 Agilent | Frequency
Freatode,
& W Sweep

Start Freq

1.80880880 GHz

Stop Freq
2.00000008 GHz

Center Freq
1.50000008 GHz

Freq Span
1.00000088 GHz

Fixed Freq
14.7508088 GHz

Hore’
lof2

—
4
To change the active graph, press the key below the display. This
key allows you to set the upper or lower graph as the active graph.

When in table or meter format the key changes the active
parameter.

You can fill the entire display and remove the menu keys, the active
function area annotation, and the display status line annotation from the
display. Press the Full Screen key to view the full screen. Pressing the
Full Screen key again returns it to the previous display.
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The Full Screen key also functions in table or meter format.

Selecting Result Types to Display

You cannot display the same result type in both graphs. If you attempt
this, an error message Each result type selected nust differ
fromall others is displayed in the status line.

To specify which measurement results are displayed

Select which measurement result is active using the key.

Press the Result key and select the result type that you want to display.

Press the key to make the other measurement result active.

Press the Result key and select the result type you want to display.

When you press the Scale key, the active measurement result’s scale
menu keys are shown.
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Figure 2-8

NOTE
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Graphical Features
Viewing a single graph

While in graph format mode, you can press the key located below

the display and the active graph fills the display as a single graph, as
shown in Figure 2-8. Pressing the key again returns the display to
dual-graph.

Displaying a single graph

4 Agilent IT

DUT Amplifier wncony OFf Autoscale

48,08 Units
dB Linear

Upper Limit
40,008

Lower Limit
-10.668

Ref Level
15.000

Display Ref
ff On

Scale/Div
5.0608

When in single graph mode, pressing the key displays the other
single graph.
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Combining two graphs on the same graph

The default setting is Combined(Off) and the graphs are not combined.

NOTE When combining two graphs the Y-scale result limits are not re-scaled
and both graphs have their own Y-scale result limits.

To combine the two graphs:
Step 1. Press the Format key and ensure Format(Graph) is selected.

Step 2. Press the Combined(On) menu key to combine the two currently displayed
graphs on the same graph.

Figure 2-9 Typical display with two traces combined on the same graph

| Format

Format,
Graph

Combined
0ff Oni

Trace,
Data

Data ->
Memory

Graticule
0ff On

Annotation
0ff Oni
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Displaying the Current Data Trace and the Recalled Memory
Trace

When a trace finishes its first complete sweep, the Data -> Memory menu
key becomes active.

To save a trace to memory, press the Data -> Memory menu key. After
pressing the Data -> Memory menu key, the Trace menu key becomes
active.

To view the saved trace, press the Trace menu key, followed by the
Memory menu key. The memory trace is presented in the display.

To view both the saved trace and the current active trace, press the Trace
menu key, followed by the Data & Memory menu key.

To view the current data trace only, press the Trace menu key, followed by
the Data menu key. This is the default setting.

Pressing Autoscale does not re-scale a memory trace.
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NOTE
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Turning the Graticule On and Off
To turn the graticule on or off:
Press the Format key.

Press the Graticule menu key to select the Graticule(Off) or Graticule(On) as
required.

Turning the Display Annotation On or Off

To turn the annotation on or off:
Press the Format key.

Press the Annotation menu key to select Annotation(Off) or Annotation(On)
as required.

When Annotation(Off) is selected and limit lines are set to Test(On) the
limit line failure indicator is disabled.

Setting the Scaling

You can set the result’s scale parameters in the active graph. To set the
scale, press the Scale key.

To change the active graph, press the Result key and select another
measurement parameter’s menu key. Press the Scale key to set the scale
of the measurement parameter.
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Figure 2-10 Typical Noise Figure Displayed on a Graph

Gl | Noise Figure

DUT Amplifier  Sys C Autoscale

10.88 Units
dB Linear

Upper Limit
16,008

Lower Limit
[.668

Ref Level
4,000

Display Ref
ff On

Scale/Div
1.6608

You can set the scale for the measurement parameter or press the
Autoscale menu key. Pressing Autoscale selects the optimum values for
Upper Limit, Lower Limit, and Scale/Div.

NOTE If limit lines are set to Display(On), and Autoscale is pressed or the scale is
changed, the limit lines may no longer appear in the display.

NOTE If a memory trace is set to display, and Autoscale is pressed or the scale is
changed, the memory trace may no longer appear in the display.
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Displaying the Measurement Results

Setting the Reference Level

The reference level minimum and maximum limits are restricted to the
values of the upper and lower scale settings.

The reference level is only visible when the Display Ref(On) is enabled.

Press the Display Ref menu key if you want the reference level displayed
in the active graph. The default setting is Display Ref(Off). Set the
Display Ref(On) to switch the reference level on.

Press the Ref Level menu key. Change the reference level value using the
RPG or the numeric keys. Values that are entered using the numeric
keys are terminated using the Enter key.
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Making Basic Measurements
Displaying the Measurement Results

Working with Markers

The marker functions only apply when you are working in graph format.

The NFA has four markers, Marker(1), Marker(2), Marker(3), and Marker(4).
The markers are coupled to both the lower graph trace and upper graph
trace.

Selecting Markers

To select a marker:

Press the Marker key.

Press the Marker menu key to select the marker of interest.

Press the State menu key and press the Normal menu key to highlight it.

A Normal State Marker

| Marker
Marker Frequency 1.505000000 G
GHz 3.474 dB B.449

Mkrl 1.5 z

— Marker
|l 2 3 4

State,
Mormal

Band Pair|

Ref Mormal

Trace
Memory

Searchr

Markers
All Off

Turn the RPG to place the markers at the point on the trace you want to

measure or use the numeric keys to enter the frequency of interest..
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To turn an active
marker off

To change the
active marker

Figure 2-12

To Switch all the
Markers Off

Making Basic Measurements
Displaying the Measurement Results

To turn an active marker off, press the State menu key and press the Off
menu key. This also removes the marker annotation above the graph and
the marker frequency from active function area.

The default active marker setting is Marker(1). To change the active
marker, press the Marker menu key. This moves the active marker from
Marker(1) to Marker(2). Press it again and it moves the active marker from
Marker(2) to Marker(3). This process is repeated until it returns to the
Marker(1).

Four Normal State Markers

: | Marker
Marker Frequency 1.8801082040 GHz
— Marker

T 1 2 3 4

State,
Mormal

Band Pair|

Ref Mormal

Trace
Data Memory

Searchr

Markers
All Off

To switch all the markers off press Markers All Off. This turns off all the
markers and associated annotation.
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Markers

Step 1.
Step 2.
Step 3.

To use Band Pair

Markers

Step 1.
Step 2.
Step 3.

Step 4.

Step 5.

Making Basic Measurements
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Changing the Marker States

The State(Delta) menu key places a reference marker at the current
position of the active marker. The delta markers enable you to measure
the difference between the reference marker and the delta marker
position on the trace.

To activate a Delta marker:
Press the Marker key.
Press the Marker menu key to select the marker of interest.

Press the State menu key and press the Delta menu key to highlight it.
Use the RPG to move the Delta marker from the reference. The
annotation displays the difference.

The State(Band Pair) menu key places two markers allowing you to choose
to move either the normal marker or the reference marker. This feature
is similar to the State(Delta) except you can choose to move either marker.
The position of the reference marker remains fixed until

Band Pair(Normal) menu key is pressed and the active marker becomes
the fixed marker. This can be altered by pressing the Band Pair(Ref) menu
key to enable the reference marker as the active marker.

To activate the Band Pair markers:
Press the Marker key.
Press the Marker menu key to select the marker of interest.

Press the State menu key and press the State(Band Pair) menu key to
highlight it.

Use the RPG to move the active marker from the reference. The
annotation displays the difference between the reference and the normal
markers position.

Pressing the Band Pair menu key sets the Band Pair(Normal) as the fixed
marker allowing you to move the reference marker. Pressing the

Band Pair menu key again sets the Band Pair(Ref) as the fixed marker
allowing you to move the normal marker.
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Figure 2-13 Band Pair with Normal Marker Enabled
- Agient | Marker
Marker Frequency 1.748826523 GHz

Marker
1 2 3 4
B.461 dB ;|
State,
Band Pair

Band Pair

Ref Mormal

Trace
Data Memory

Searchr

Markers
All Off
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Marking Memory Traces

To place a marker on the recalled memory trace:

Enable the Trace(Memory) menu key.

Set the marker you want to use to Normal, Delta, or Band Pair.

The marker is placed on the memory trace. If Trace(Data&Memory) on the
format menu is enabled, switching between Trace(Data) and
Trace(Memory) switches the marker between the traces.

If a marker is set to Trace(Memory) and the Memory trace is not
displayed, the marker and its annotation are not displayed.
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Searching with Markers

NOTE If you are searching continuously the markers have additional
annotation which identifies which marker is the minimum and the
maximum. The annotation is “[’ a minimum, “[J’ a maximum. If you
change the active graph the annotation remains on the original graph.

Searching for Min  You need to have activated a Normal or Delta marker state to perform a
or Max point minimum or maximum search.

Figure 2-14 Typical Trace showing Maximum Point Found

o bl | Search
Marker Frequency 1.123743841 GHz
Mkrl 1.8714 GHz dB 5 dB l 2 ngkez
Search Type,
Max
Continuous
0ff On
Find

To search for the maximum point:
Step 1. Press the Search menu key.

Step 2. Press the Search Type menu key to select the Search Type(Max).
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Step 3. Press the Find menu key.

If you want to continuously find the maximum point on the trace, select
Continuous(On).

Searching for Peak You need to have activated a marker state to Band Pair to perform a
to Peak points Peak to Peak search.

Figure 2-15 Peak to Peak Found

= Agilent | Search
Reference Marker Frequency 1.362068965 GHz ark
arker

-2.947 o [ A

Search Type,
Pk—Pk

Continuous
tf On

Find

Step 1. Press the Search menu key.
Step 2. Press the Search Type menu key to select Pk-Pk.
Step 3. Press the Find menu key.

If you want to continuously find the maximum and minimum points on
the trace, select Continuous(On).
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Indicating an Invalid Result

Several invalid result conditions may exist simultaneously. These
conditions are ranked in order of severity and only the most severe
condition present is displayed.

The ranking order is:

Table 2-2 Ranking Order of Invalid Result Conditions

Ranking Order | Invalid Result Condition Marker Indicator

1 Hot power < cold power

2 Corrected calculation not possible “XX

3 Measurement result calculation
invalid

The ranked order 2 only occurs if a corrected measurement is requested
and either:

= The input range used at this measurement point is not calibrated.

= The input range is calibrated, but the calibration data is invalid at
this point.

See the User’s Guide for further information about the over and under

range indicators.
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3

Advanced Features

This chapter describes how to use the Limit Lines and Loss
Compensation features on your Noise Figure Analyzer. It also covers how
to make manual measurements.
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What You will Find in this Chapter

This chapter covers:

Setting up Limit Lines and using them for pass/fail testing of the
measurements.

Using Loss Compensation and using this to correct for system losses
in cabling, switches, or connectors and so forth. Also, the use of S2P
file formats to create Loss Compensation Tables.

Making Manual Measurements.
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To change the
Limit Line

Setting the Type of
Limit Line

Enabling Testing
against a Limit
Line

NOTE

Figure 3-1

To Display a Limit
Line

Advanced Features
Setting up Limit Lines

Setting up Limit Lines

The NFA features four independent Limit Lines. The Limit Line(10) and
Limit Line(20) are applied to the upper graph, and Limit Line(30) and
Limit Line(40) are associated with the lower graph.

The default limit line setting is Limit(10). To change the active indicator,
press the Limit Line menu key. This moves the active indicator from
Limit Line(10) to Limit Line(20), press it again and it moves the active
indicator from Limit Line(20) to Limit Line(30). This process is repeated
until it returns to the Limit Line(10).

To set the limit line type, choose Type(Upper) if you want it to be above the
trace or Type(Lower) if you want it to be below the trace. Each of the four
limit line needs to be set up separately.

To set the testing of the trace against the limit line, choose Test(On) if you

want the result reported or Test(Off) if you do not want the result
reported. Each of the four limit lines need to be set up separately.

After a failure the LI M TS FAI L: indicator remains displayed until you
either switch Test(Off), change the limit line type, or press Restart.

Limit Fail Indicator

2 Agilent

FAIL: J

’ \ Limit Fail Indicator

To display the limit line on the graph, choose Display(On). To not display
the limit line on the graph, choose Display(Off). Each of the four limit line
needs to be set up separately.
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Step 1.
Step 2.
Step 3.
Step 4.

Step 5.
Step 6.

NOTE

Advanced Features
Setting up Limit Lines

To switch all the Limit Lines off, press Limit Lines All Off. This
simultaneously switches off all Limit Lines, regardless of what graph or
trace they are associated with and setting both Test(Off) and Display(Off).

When a limit line is switched off the limit line data is not affected.

Creating a Limit Line

Press the Limit Lines key and select the limit line you want to create.
Press the Editor menu key.

Enter the first Frequency value. Press the Tab key.

Enter the first Limit or Y-axis unit value. Press the Tab key.

For a limit line value to be useful, it should be derived from the scale
values you are using to display the trace.

Press the arrow key to change Connected to either Yes or No.
Repeat this process until the limit line is defined.

The limit line is now defined. Press the Prev key or Limit Line key to
return to the limit line menu. When saving a limit line table you need to
specify which limit line number. See “Saving a File” on page 18.

You can load a previously saved Limit Line table. However, you need to
specify which limit line number you want loaded. See “Loading a File” on
page 19.
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Step 1.
Step 2.

Advanced Features
Using Loss Compensation

Using Loss Compensation

You can configure the NFA to compensate for losses due to cabling,

connectors and temperature effects that occur in the measurement
setup. These can be between the Noise Source and the DUT, Before DUT,
and/or between the DUT and the NFA input, After DUT.

You can also use S2P data file formats output from a Network Analyzer
to create Loss Compensation tables. The NFA converts the S2P file
format to a Loss Compensation table. If you are using S2P file formats
see the User’s Guide for an explanation.

Configuring Fixed Loss Compensation

Press the Loss Comp key

Press the Setup menu key to access the Loss Conpensati on Set up form,
see Figure 3-2

Loss Compensation Setup Form

- Agilent | Before Comp
Before DUT Off

Off
Loss Compensation Setup
Fixed
Before DUT Off
Before DUT Fixed Value Table
Before Temperature 0.06 K
After DUT 0ff

After DUT Fixed Value
After Temperature B.00 k

Move the highlight to select a field using the 'Tab' keys.
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Step 6.

Step 1.
Step 2.
Step 3.

Step 4.

NOTE
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When configuring loss compensation before the DUT, use the Tab key to
navigate to the Before DUT field and set before DUT to fixed by selecting
the Fixed menu key to highlight it.

To set the loss compensation value before the DUT, use the Tab key to
navigate to the Before DUT Fixed Value field and input the required value
for the loss occurring before the DUT.

When configuring loss compensation after the DUT, use the Tab key to
navigate to the After DUT field and set after DUT to fixed by selecting the
Fixed menu key to highlight it.

To set the loss compensation value after the DUT, use the Tab key to
navigate to the After DUT Fixed Value field and input the required value for
the loss occurring after the DUT.

Configuring Table Loss Compensation

Press the Loss Comp key
Press the Setup menu key to access the Loss Conpensati on Set up form.

When configuring table loss compensation before the DUT, use the Tab
key to navigate to the Before DUT field and select the Table menu key to
highlight it.

When configuring table loss compensation after the DUT, use the Tab key
to navigate to the After DUT field and select the Table menu key to
highlight it.

You can load a previously saved Loss Compensation table. However, you
need to specify whether the Loss Compensation table is an After Table or
a Before Table. See “Loading a File” on page 19.
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Creating a Loss Compensation Table
To create a loss compensation table .
Press the Loss Comp key, and the Before Table menu key.

Enter the Loss Frequency value in the table using the numeric keys.
Terminate it using the unit menu keys.

Press the Tab key to move the highlight to the Loss Value column and
enter the corresponding Loss Value.

When terminating the Loss Value you can use either dB or linear menu
keys. However, the result appears in the table in dB.

Press the Tab key to move the highlight to the Loss Frequency column
and enter the next Loss Frequency Value.

Repeat steps 2 to 4 until all the Loss Frequency and Loss Values you
need are entered.

After completing the Loss Compensation table entries, press the Prev key
or Loss Comp key to return to the Loss Compensation menu.

Once you have completed entering the Loss Compensation data, save the
Loss Compensation table using the File key.

If you do not save the Loss Compensation table, you may lose the data.
This depends on your Power On/Preset condition.
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Advanced Features
Using Loss Compensation

Setting Temperature of Loss

Step 1. Press the Loss Comp key

Step 2. Press the Setup menu key to access the Loss Conpensati on Set up form,

See .

Loss Compensation Setup Form with Temperature Selected

2 Agilent

Before DUT Off

Loss Compensation Setup

Before DUT
Before DUT Fixed Value
Before Temperature

After DUT
After DUT Fixed Value
After Temperature

Off
oo
294,60 K

Off
e
394.88 K

Move the highlight to select a field using the 'Tab' keys.

| Before Comp

Off
Fixed

Table

Step 3. To set the temperature value before the DUT, use the Tab key to navigate
to the Before Temperature field and input the required temperature of loss

value occurring before the DUT.

Step 4. To set the temperature value after the DUT, use the Tab key to navigate
to the After Temperature field and input the required temperature of loss

value occurring after the DUT.
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Making Manual Measurements

The Noise Source is turned on or off by the appropriate Noise Source(On)
and Noise Source(Off), for example, Noise Source(On) provides Phot.

The following paragraphs give a step-by-step procedure for making the
measurement. Several steps are required for measurements at each
frequency point.

When calibrating a series of frequency points and an error is made on
one of the points, you need to start calibrating the series of frequency
points again. Press the Calibrate key to reset the calibration.

When measuring a series of frequency points and an error is made on one
of the points, you need to start measuring the series of frequency points
again. Press the Restart key to reset the measurement.

Manual Measurements Procedure

Between each stage of this procedure, ensure you wait until the data
invalid indicator has disappeared before you proceed.

The steps of a typical measurement are as follows:
Find and hold RF/UW attenuators.

1. Connect the hot source, Ty, to the DUT input, and the DUT output to
the NFA.

2. Press Noise Source(On) to measure noise power with the source at Ty,.

3. Press RF/UW Att(Hold) to hold RF attenuators for the entire
measurement.
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Step 3.
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Calibrate.

1.
2.

Remove the DUT and connect the noise source to the NFA
Press Calibration (On) to calibrate with noise source at Phot.

Press IF Att(Hold) to hold the IF attenuators fixed at the new value or
use the previously defined IF Att(Fixed) value.

Press Accept to store the Phot calibration reading.
Press Noise Source(Off) to select the Pcold calibration reading.

Press Accept to store the Pcold calibration reading.

Measure.

o > w N

o

Press Calibration (Off).

Connect Noise Source to the DUT and the DUT to the NFA.
Press Noise Source(On) to select the Phot reading.

Press IF Att(Auto) to allow the IF attenuators to autorange.

Press IF Att(Hold) to hold the IF attenuators fixed at the new value or
use the previously defined IF Att(Fixed) value.

Press Accept to store Phot measurement result.

Press Noise Source(Off) and press Accept to store Pcold measurement.

If you have set up to measure a number of points over a frequency range.
You need to change the point number by pressing the Point menu key and
entering the point number and repeat the procedure from the next

measurement point. Repeat this until all the points have been measured.

The points need not be measured sequentially.
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Making Extended Frequency
Measurements

This chapter describes how to make measurements outside the baseband
frequency range of your Noise Figure Analyzer.
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What You will Find in this Chapter

This chapter covers:
= Overview of Configuring Extended Frequency Measurements
= An overview of the Measurement Modes

= Connecting the System
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Making Extended Frequency Measurements
Overview of Configuring Extended Frequency Measurements

Overview of Configuring Extended Frequency
Measurements

Configuring extended frequency measurements involves four steps.

Press the System key and configure the measurement system parameters
as required using the GPIB and External LO menu items.

System Parameters

Parameter Description

NFA Address This sets the NFA's GPIB address.
Valid addresses are from 0 to 30.
The default address is 8.

External LO Address This sets the GPIB address of the
External LO attached to the LO GPIB
port.

Valid addresses are from 0 to 30.
The default address is 19.

LO GPIB Address This sets the address through which
other devices, attached to the LO GPIB,
communicate with the NFA.

Valid addresses are from 0 to 30.
The default address is 8.

Command Set This sets the External LO command
language. The default setting is
Command Set(SCPI) to operate a SCP
compliant LOCommand Set(Custom)
is used when the External LO is not
SCPI compliant and operated using the
custom command strings.

LO Commands This accesses tbg ernal LO
Commands Form. The form is used to
enter the commands used to control 4

non-SCPI-compliant External LO.
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Table 4-1 System Parameters

Parameter Description

Settling Time This sets the settling time of the
External LO. Thisisused as a settling
period after the External LO frequency
is changed.

Min and Max Frequency This sets the minimum and maximum
frequencies of the External LO.

Multiplier This sets the multiplier value of the
External LO freguency.

Step 2. Press the Meas Mode key to configure the measurement mode of the
Noise Figure Analyzer.

For more details on the available measurement modes, see
“Measurement Modes” on page 77.

Step 3. Press the Mode Setup key to configure the measurement mode
parameters for the specific measurement mode you have selected.

Step 4. Configure the measurement (measurement frequency range, number of
measurement points and averages and so forth) using the
Frequency/Points and Averaging/Bandwidth keys.

For more details on configuring measurements, including calibration, see
Chapter 2, “Making Basic Measurements,” on page 23.
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Measurement Modes

Measurement Modes

The Noise Figure Analyzer offers the following measurement modes
through the Meas Mode key on the front panel:

The DUT is an amplifier-type device with no frequency conversion.
This is the basic measurement mode where the measurement
frequency is within the NFA's frequency range.

The DUT is an amplifier-type device with frequency downconversion
occurring in the measurement test setup (system downconversion).
The LO can be either fixed or variable in this case.

The DUT is a frequency downconverter (that is, frequency
downconversion occurs in the DUT itself and not in the measurement
test setup). The LO can be fixed or variable.

The DUT is a frequency upconverter (that is, frequency up conversion
occurs in the DUT itself and not in the measurement test setup). The
LO can be fixed or variable.

The Amplifier measurement mode is for any DUT that does not perform
frequency conversion and includes amplifiers, filters, attenuators and so
forth.

Noise figure measurements involving mixers are necessary when:

The frequency conversion is part of the DUT. For example, the DUT is
a mixer or a receiver.

The frequency conversion is part of the measurement test set-up. The
DUT is to be measured at a higher frequency than the NFA's
frequency range covers, hence an external mixer and local oscillator
are added to the measurement test set-up to convert this frequency to
a frequency within the NFA's range.
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Figure 4-1

Making Extended Frequency Measurements
Measurement Modes

The NFA can make a single frequency conversion, either in the DUT, or
as an added System Downconverter, which configures the NFA as a
frequency range extender. The NFA can also control an LO source
remotely using the SCPI commands or the custom commands. Under this
control the LO can be swept.

Basic Measurement — No Frequency Conversion

The basic measurement setup is shown in Figure 4-1, allowing you to
compare more complex setups with it.

Basic Noise Figure Measurement — No Frequency Conversion

Calibration Setup

Noise Source

M easurement Setup

Noise Source

DUT

When an uncorrected measurement is performed, the result is the
measured Noise Figure of all of the components after the noise source.
When the calibration setup is connected and the calibration performed,
the NFA measures its own noise figure and the connection set up. When
a corrected measurement is performed, the contribution of the
calibration setup is removed from the uncorrected result, giving a
corrected measurement of the DUT only.
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Measurement Modes

For these measurements the NFA mode is set to

DUT

Amplifier

System Downconverter

Off

The RF input section on all NFA models has a built-in 3.0 GHz Low Pass

Filter. This filter needs to accounted for when planning your filter

requirements during calibration and measurement.

On the N8974A and the N8975A models the microwave input section has

no filtering. This needs to accounted for when planning your filter
requirements for calibration and measurement. This is also important
when making measurements which cross over the 3.0 GHz switch.

Chapter 4
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Measurement Modes

Frequency Down-converting DUT

In this mode, the DUT contains a frequency down-converting device, for
example, a mixer or receiver.

There are two modes to choose from:

1. Avariable frequency LO and fixed IF.

Making this measurement, the NFA remains locked at one frequency
and the LO sweeps.

2. A fixed frequency LO and variable IF.

Making this measurement, the LO remains locked at one frequency
and the NFA sweeps.

NOTE Filtering is needed to remove the unwanted sideband when making
single-sideband measurements in both modes. Ideally these filters
should be included in the calibration path and measurement path.
However, if it is not in the path, you can enter loss compensation to
account for any additional error.

80 Chapter 4



NOTE

Making Extended Frequency Measurements
Measurement Modes

Fixed IF Variable LO (8970B Mode 1.3)
This is an overview of the key presses needed to set up the mode.

In the Measur ement Mbde For mset the following:

DUT Downconv

System Downconverter No Access

LO Mode Variable

In the Mode Set up For mset the following:

IF Frequency Enter avalue
Sideband LSB, USB or DSB
LO Control On

External LO Power Level | Entervalueandterminate
using either dBm or W

The External LO Power Level is displayed on the NFA as dBm.

In the Frequency menu, frequencies are specified as RF (input to DUT)
frequencies.
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Measurement Modes

Variable IF Fixed LO (8970B Mode 1.4)
These are an overview of the key presses needed to set up the mode.

In the Measur ement Mbde For mset the following:

DUT Downconv

System Downconverter No Access

LO Mode Fixed

In the Mbde Set up For mset the following:

LO Frequency Enter avalue
Sideband LSB, USB or DSB
LO Control Off or On

External LO Power Level | Entervalueandterminate
using either dBm or W

NOTE The External LO Power Level is displayed on the NFA as dBm.

In the Frequency menu, frequencies are specified as IF (output from
DUT) frequencies.
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Measurement Modes

Frequency Up-converting DUT

In this mode, the DUT contains a frequency up-converting device, for
example, a transmitter.

There are two modes to choose from:

1. Avariable frequency LO and fixed IF.

Making this measurement, the NFA remains locked at one frequency
and the LO sweeps.

2. A fixed frequency LO and variable IF.

Making this measurement, the LO remains locked at one frequency
and the NFA sweeps.
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Fixed IF Variable LO (8970B Mode 1.3 with SUM Sideband)

These are an overview of the key presses needed to setup using this
mode. In this mode, the DSB measurement is not allowed.

In the Measur ement Mbde For mset the following:

DUT Upconv

System Downconverter No Access

LO Mode Variable

In the Mode Set up For mset the following:

IF Frequency Enter avalue
Sideband LSB or USB
LO Control On

External LO Power Level | Entervalueandterminate
using either dBm or W

NOTE The External LO Power Level is displayed on the NFA as dBm.

In the Frequency menu, frequencies are specified as RF (input to DUT)
frequencies.
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Variable IF Fixed LO (8970B Mode 1.4 with SUM Sideband)

These are an overview of the key presses needed to set up using this
mode. In this mode, the DSB measurement is not allowed.

In the Measur emrent Mbde For mset the following:

DUT Upconverter

System Downconverter No Access

LO Mode Fixed

In the Mode Set up For mset the following:

LO Frequency Enter avalue
Sideband LSB or USB
LO Control Off or On

External LO Power Level | Entervalueandterminate
using either dBm or W

NOTE The External LO Power Level is displayed on the NFA as dBm.

In the Frequency menu, frequencies are specified as IF (output from
DUT) frequencies.
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System Downconverter

The DUT is a non-frequency converting device, for example an amplifier
or filter, and its frequency is higher than the NFA's measurement range.
Frequency down-conversion is required within the measurement system,
using a mixer, external to the DUT, to convert the signal of interest to the
frequency range of the NFA.

There are two modes to choose from:

1. Avariable frequency LO and fixed IF.

Making this measurement, the NFA remains locked at one frequency
and the LO sweeps.

2. A fixed frequency LO and variable IF.

Making this measurement, the LO remains locked at one frequency
and the NFA sweeps.

Filtering is needed to remove the unwanted sideband when making
single-sideband measurements in both modes. Ideally any filtering is
included in the calibration path and measurement path. However, if it is
not in the path, you can enter loss compensation to account for any
additional error.
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Making Extended Frequency Measurements
Measurement Modes

Fixed IF Variable LO (8970B Mode 1.1)

These are an overview of the key presses needed to set up using this
mode.

In the Measur emrent Mbde For mset the following:

DUT Amplifier

System Downconverter On

LO Mode Variable

In the Mode Set up For mset the following:

IF Frequency Enter avalue
Sideband LSB, USB or DSB
LO Control On

External LO Power Level | Entervalueandterminate
using either dBm or W

NOTE The External LO Power Level is displayed on the NFA as dBm.

In the Frequency menu, frequencies are specified as RF (input to DUT)
frequencies.
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Making Extended Frequency Measurements
Measurement Modes

Variable IF Fixed LO (8970B Mode 1.2)

These are an overview of the key presses needed to set up using this
mode.

In the Measur ement Mbde For mset the following:

DUT Amplifier

System Downconverter On

LO Mode Fixed

In the Mode Set up For mset the following:

LO Frequency Enter avalue
Sideband LSB or USB
LO Control Off or On

External LO Power Level | Entervalueandterminate
using either dBm or W

NOTE The External LO Power Level is displayed on the NFA as dBm.

In the Frequency menu, frequencies are specified as RF (input to DUT)
frequencies.
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Step 1.

Step 2.

Step 3.

Step 4.

Making Extended Frequency Measurements
Connecting the System

Connecting the System

Figure 4-2 and Figure 4-3 show the connection diagram options you can
use to calibrate the NFA and after calibration, to measure a DUT,
whether it is a down-converter mixer, up-converter mixer, amplifier, or
filter. It does not show where to place a filter to remove any unwanted
sideband or input noise.

Setting Up the Noise Figure Analyzer
To connect the NFA to make measurements.

Connect a GPIB cable between the NFA's LO GPIB rear panel connector
and the Local Oscillator's GPIB connector.

Turn on both instruments and press the Preset key to return the NFA to
a known state.

The NFA can control the Local Oscillator, over its General Purpose
Interface Bus (LO GPIB) without the need for an external controller. The
NFA does not send LO controlling commands over it's main GPIB. LO
control is only done over it's LO GPIB.

Enter the ENR values in to the NFA. See “Entering Excess Noise Ratio
(ENR) Data” on page 25 for the procedures to do this.

Follow the procedure to calibrate the system, and measure the DUT, in
the mode to suit your needs.
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Connecting the System

Figure 4-2 System Downconverter Mode
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Making Extended Frequency Measurements
Connecting the System

Figure 4-3 Frequency Converting DUT Measurement Modes
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Connecting the System
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Performing System Operations

This chapter describes how to perform the system-level tasks, such as
configuring the Noise Figure Analyzer's GPIB address, defining the
preset conditions and so forth.
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Performing System Operations
What You will Find in this Chapter

What You will Find in this Chapter

This chapter covers:

Setting the GPIB Addresses

Configuring the Serial Port

Configuring the Internal Alignment

Displaying Error, System and Hardware Information
Presetting the Noise Figure Analyzer

Defining the Power-On/Preset Conditions

Restoring System Defaults

Setting the Time and Date

Configuring a Printer with the NFA
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Performing System Operations
Setting the GPIB Addresses

Setting the GPIB Addresses

To Set the GPIB Addresses

Step 1. Press the System key

Step 2. Press the GPIB menu key.

Figure 5-1 System GPIB Form

I NFA Address

Noise Figure Analyzer Address 8
R R, yraaddress
8

System GPIB Form

Noise Figure Analyzer Address|s

External LO Address 19
LO GPIB Address 8

Move the highlight to select a field using the 'Tab' keys.

Step 3. Using the Tab key to navigate through the form configure the GPIB
parameters as required.

For a description of the GPIB parameters, see the analyzer online help or
the User’s Guide.

NOTE Ensure the Remote Port menu key is set Remote Port(GPIB).

Chapter 5 95



Figure 5-2

Step 1.
Step 2.

Step 3.

Performing System Operations
Configuring the Serial Port

NOTE

Configuring the Serial Port

Press the System key
Press the Serial menu key.

The System Seri al For mnow appears. See Figure 5-2

System Serial Form

| Baud
Baud 9600

1200
System Serial Form
2400
Data Terminal Ready OFF
Request To Send OFF 4800
Baud 9606 JEE
Receive Pacing KON/ HOFF 9600
Transmit Pacing KON/ HOFF
19200
38400
Move the highlight to select a field using the 'Tab' keys.

Use the Tab keys to navigate through the form and the menu keys to
configure the serial parameters as required.

For a description of the serial parameters, see the analyzer online help or
the User’s Guide.

Ensure the Remote Port menu key is set Remote Port(Serial). The NFA
needs a power cycle to take effect if you changed it from
Remote Port(GPIB),
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Step 1.
Step 2.
Step 3.

Step 1.
Step 2.
Step 3.

Performing System Operations
Configuring the Internal Alignment

Configuring the Internal Alignment

Data from the internal alignment routine is necessary for accurate NFA
operation. When enabled, the internal alignment routine runs
continuously to ensure that the NFA is using current alignment data
which improves the NFA's accuracy.

Turning Alignment Off and On

Press the System key.
Press the Alignment menu key to access the Alignment menu.

Press the Alignment menu key selecting Alignment(On) or Alignment(Off) as
required.

The default setting is Alignment(On).

Changing Alignment Mode

Press the System key.
Press the Alignment menu key to access the Alignment menu.

Press the Alignmnt Mode menu key selecting Alignmnt Mode(Point) or
Alignmnt Mode(Sweep) as required.

The default mode setting is Alignmnt(Sweep).
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NOTE

Step 1.
Step 2.
Step 3.

Step 4.
Step 5.

Performing System Operations
Configuring the Internal Alignment

Alignment of the YIG Tuned Filter (YTF)

The YTF alignment feature only applies to the N8974A and the N8975A
models.

Press the System key.
Press the Alignment menu key to access the Alignment menu.
Press the Align YTF menu key to set the YTF alignment.

You are prompted to press this key again. This feature ensures you do
not accidently erase the current YTF alignment data.

Wait until the Alignment routine has completed.

Press the Save YTF Alignment menu key to store the Alignment data.
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Step 1.
Step 2.

Step 1.

Step 2.

Step 1.
Step 2.

Performing System Operations
Displaying Error, System and Hardware Information

Displaying Error, System and Hardware
Information

Displaying the Error History

Press the System key and the More 1 of 3 menu Kkey.
Press Show Errors menu key to view the error queue.

To clear the error screen, press Clear Error Queue.

Displaying System Information
Press the System key and the More 1 of 3 menu key.

Press Show System menu key to view system information.

Displaying Hardware Information

Press the System key and the More 1 of 3 menu key.

Press Show Hdwr menu key to view hardware information.
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Step 1.

Step 2.
Step 3.

Performing System Operations
Presetting the Noise Figure Analyzer

NOTE

Presetting the Noise Figure Analyzer

To preset the analyzer using its factory defaults:

Turn the NFA on by pressing the On key and wait for the power on
process to complete.

Press System key, More 1 of 3, Power On/Preset, Preset (Factory) menu keys.

Press the green Preset key.

Turning on the analyzer performs an instrument preset. Turning on the
analyzer also fetches alignment data; clears both the input and output
buffers; and sets the status byte to 0. The last state of the analyzer before
it was turned off is recalled when Power On(Last) is selected (under the
System key).
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Step 2.
Step 3.

Step 1.
Step 2.
Step 3.

Step 1.
Step 2.
Step 3.
Step 4.
Step 5.

Performing System Operations
Defining the Power-On/Preset Conditions

Defining the Power-On/Preset Conditions

The power up and preset conditions can be different if required. You can
set the NFA to return it to a user-defined state after a power on or preset.

Setting the Power On Conditions

Press the System key and the More 1 of 3 menu key.
Press the Power On/Preset menu key.
Set Power On to Power On(Last) or Power On(Preset) as required.

‘Last’ means that the instrument, upon power on returns to the state it
was in when it was powered off.

‘Preset’ means the instrument returns to its defined preset state.

Setting the Preset Conditions

You can set the NFA to return to its factory default state or a user
defined state upon preset. The configured user defined state is provided
by pressing the Save User Preset menu key to save the current NFA state

To set the preset conditions to factory default
Press the System key and the More 1 of 3 menu Kkey.
Press the Power On/Preset menu key.

Enable the Preset(Factory) menu key.

To set the preset conditions to user defined
Configure the NFA to the desired state.

Press the System key and the More 1 of 3 menu key.
Press the Power On/Preset menu key.

Enable the Preset(User) menu key.

Press the Save User Preset menu key to save the current NFA state.
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Step 1.
Step 2.
Step 3.

Performing System Operations
Restoring System Defaults

Restoring System Defaults

Press the System key
Press the More 1 of 3 menu key.

Press the Restore Sys Defaults menu key.
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Step 1.
Step 2.
Step 3.
Step 4.

Step 1.
Step 2.
Step 3.
Step 4.

Step 5.
Step 6.

Performing System Operations
Setting the Time and Date

Setting the Time and Date

To turn the time and date on and off

Press the System key.

Press the More 1 of 3 menu key.

Press the Time/Date menu key.

Press the Time/Date menu key to select Time/Date(On) or Time/Date(Off) as

required.

To set the time and date

Press the System key.
Press the More 1 of 3 menu key.
Press the Time/Date menu key.

Set the Date Mode to either US format MDY (Month/Day/Year) or
European format DMY (Day/Month/Year).

Enter the time in hhmmss (hours, minutes, seconds) format.

Enter the date in yyyymmdd (year, month, day) format.
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Printer connection

Step 1.
Step 2.

Step 3.

Performing System Operations
Configuring a Printer with the NFA

Configuring a Printer with the NFA

To connect your printer to the NFA, connect the printer to the parallel
I/O interface connector of the NFA using an IEEE 1284 compliant
parallel printer cable.

If appropriate, configure your printer (see your printer documentation
for more details on configuring your printer).

To Configure a Printer with the NFA

Power on the NFA and the printer.

Press the Print Setup key and then press the Printer Type menu key. Refer
to the analyzer online help or User’s Guide for a description of the
options.

Press Printer Type to access the Printer Type menu keys and press Auto to
make the NFA attempt to identify the connected printer.

The printer should now be automatically recognized by the NFA. If the
printer is not automatically recognized, then see the User’s Guide for
more details on printer setup.

Testing Correct Printer Operation

When printer setup is complete test correct printer operation by pressing
Print Setup, Print (Screen) and then pressing the Print key to print a test

page.
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